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Preface

This guidebook introduces the procedures to replace PFXSP5B41 + PFXZCDADEXP1 with PS6000 series
Basic Box Module. The recommended replacement models are as shown below.

Currently used device Recommended replacement model

SP-5B41 (Open Box)

+ PFXZCDADEXP1

(DC Power Supply Adapter)
PFXSP5B41 =
or PEXSP5B411
or PEXSP5B412
+ PFXZCDADEXP1

PS6000 Basic Box (Atom)
Model : PFXP6ABxxxxxxxxx00 (Intel X6211E Atom 2 Cores DIMM-4GB)

Safety Information
To properly use the products described in this book, please follow the directions below.
eBe sure to read the manual and the other provided documents before use.

e Only persons with the expertise of electrical equipment construction method and related
law and also the adequate skills should be allowed to install, connect, and maintain the
products.

We are not responsible for death, serious injury or unintended equipment damage
incurred as the result of failure to follow these instructions.

Trademarks

Microsoft® and Windows® are either registered trademarks or trademarks of Microsoft Corporation in the
United States and/or other countries.

Intel®, Celeron®, Atom®, Core™2 Duo and Core™ i3/5/7 are trademarks of Intel Corporation.

Other product names used in this manual may be the registered trademarks owned by the respective
proprietors.



Models of PS6000 series

PS6000 series are products of CTO (Configure To Order).
Please confirm CTO models on the Web site before placing orders at the time of purchase.

Generate CTO models.
https://www.proface.com/en/product/ipc/ps6000/configurator



https://www.proface.com/en/product/ipc/ps6000/configurator
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Chapter 1 Specifications Comparison
1.1 Comparison of performance specifications between PFXSP5B41 + PFXZCDADEXP1 and PS6000

Basic Box

Performance Specifications

PFXSP5B41 +
PFXZCDADEXP1

PS6000
Basic Box

Main memory

DDR3L 1066 MHz - SDRAM 2 GB

SP-5B411/412:
DDR3L SDRAM 4 GB

UP! Atom
Atom E3825
X6211E
Base frequency 1.33 GHz 1.30 GHz
Max turbo boost UP!'3.00 GHz *
CPU - *Default: disable
frequency
enable from BIOS
L2 cache 1 MB 1.5 MB
Core number 2
Thread number 2
SP-5B41:

UP! 260-pin SO-DIMM socket x 2,
DDR4-3200 (Up to 32GB for 2 sockets)

UP! Support In-band ECC

Graphics accelerator

Intel® HD Graphics for Intel Atom®
Processor Z3700 Series

UP! Intel® UHD Graphics for 10th Gen
Intel® Processors

Security chip

UP! TPM 2.0

BIOS

Legacy BIOS

UP! UEFI BIOS

Operating system

SP-5B41:
Open Box (Windows® Embedded
Standard 7 Service Pack 1)

SP-5B411/412:
Windows® 10 loT Enterprise 2019
LTSC 32 bit

UP! Windows® 10 IoT Enterprise 2021
LTSC (64bit) *1

Watchdog timer

New! Timeout setting from either 1 to
255 seconds, or 1 to 255 minutes, is
possible (set up using API)

Buzzer

Yes

Yes

*1 OS will be different between SP5000 and PS6000. Be aware that SP-5B411/412 windows 10 and
PS6000 Basic Box is both Windows 10 but different version. Some software might have no compatibility.
SP-5B411/412 : Windows® 10 loT Enterprise 2019 LTSC (32 bit)
PS6000 Basic Box : Windows® 10 IoT Enterprise 2021 LTSC (64bit)




1.2 Comparison of general specifications between PFXSP5B41 + PFXZCDADEXP1 and PS6000 Basic

Box

General Specifications

PFXSP5B41 +
PFXZCDADEXP1

PS6000
Basic Box

External dimensions
(including bezel)

W188.0 x H131 x D67 mm

Front bezel material

Aluminum

Weight

1.65 kg or less

3.7 kg or less

Cooling method

Natural air circ

ulation (fanless)

—See 2.1

Power supply

DC power supply : 24V

DC power supply: 24V

Max: 25 W

No power supplied to outside: 35 W
Max: 53 W

DC
Power
consump
tion
AC

UPS for battery
backup

No exclusive option
*please us third device
recommend : APC SMT500J Smart-

UPS500




1.3 Comparison of interface specifications between PFXSP5B41 + PFXZCDADEXP1 and PS6000

Basic Box

Interface Specifications

PFXSP5B41 +
PFXZCDADEXP1

PS6000
Basic Box

Main
unit

COM1: RS-232C/422/485 (non-
isolated)

COM2: RS-232C/422/485 (non-
isolated)

(default: RS-485, enable by
launcher)

COML1: RS-232C/422/485 (non-isolated)
COM2: RS-232C/422/485 (non-isolated)
(default: RS-485, enable by BIOS) — See
2.2

*not support VCC(DC5V) output function
of RS232C COM port

Serial
(D-Sub
9-pin

plug)

Option

Select any of the following
PFXYP6M2R23P2 : RS-232C isolated
type x2

PFXYP6M2R42P2 : RS-422/485 isolated
type x2 *

— See 3.3

* No compatibility in case of RS-422 using
RTS+/- or CTS+/-. But even in other case, if
application or connected device is controlling
send/receiving by monitoring RTS or CTS, it
could not be communicated. If able to change to
software flow control, it is avoidable.

Disk

CFast Card 32 GB x 1

SDXC Card x1

UP! M.2 SSD 128GB as default, support
up to 512GB x2*

SDXC Card x1

*2" SSD could be use when no option
interface or Wifi/Bluetooth interface
module.

With other option module, only single SSD
can be use — See 3.2

USB

USB Type-A x3 (2.0)
USB Type-mini-B x1 (2.0) *
*for transporting project file

UP! USB Type-A x2 (3.0)

UP! USB Type-C x1 (3.2)

*Project transfer will be done by :
Ethernet
USB A transfer cable (PFXZC3CBUSAL)
USB Memory
SD Card

Ethernet

EEE802.3, 10BASE-T/100BASE-
TX/1000BASE-T x2

UP! IEEE1588, 10 BASE-T/ 100 BASE-
TX/1000BASE-T, Wake on LAN (WOL)
supported x2

* When status is S4 (hybrid shutdown), Wake on
LAN cannot be used.

Sound

Line input/Line output/Microphone
input

Line output/Microphone input
(Option: PEXYP6CVUSAU)

Video output

DVI-D Output Interface x 1

UP! Display port x1 (Dual mode
supported)

UP! USB 3.0 (Type C Display port
Alternate mode) x 1

— See 2.3

Option Interface
Slot

1 slot
*For valid combination —See 3.2




Chapter 2 Hardware Compatibility
2.1 Cooling storage media
When installing the M.2 SSD for second storage, the optional M.2 cooling kit is required. (PFXYP6HSM2B)
| Storagemedia | M.2coolingkit |
M.2 SSD -
Basic Box M.2 SSD (Second Storage) V4
CF Card -

1. Remove 3 screws on the front side of the Box Module.

2. Remove the optional interface cover.

3. Peel off the protective film from the top surface and bottom surface of the heat sink pad.

Place the heat sink pad on the board

)
7,

/
/

gf
/

4. Insert the M.2 screw in the M.2 SSD card.



5. Insert the M.2 SSD card in the slot. Secure the M.2 SSD card with the M.2 screw

2.2 Settings of Serial Interfaces on Box Module

The following describes how to configure the serial interfaces on Box Module.

1. Turn on the product. While the boot screen is displayed, press either the [DEL] or [ESC] key. Enter the
password (default password: Pw#12345). The BIOS screen will display.

2. Select Advanced > Super |0 Configuration > Serial Port 1 or Serial Port 2

3. Select Enabled or Disabled in Serial Port (default: Enabled).

4. Select a communication method in Mode Selection (default: RS485).

2.3USB Type C
The USB Type C of PS6000 series supports DP Alt Mode *1.
PS6000 Basic Box Type C does not support USB-PD *2

*1 DP Alt Mode (DisplayPort Alternative mode) is USB Type C port which could connect to display by
convert adapter or cable of VGA, DVU, HDMI. DP.

*2 USB-PD (Power Delivery) is USB port which able to connect to display by 1 cable. By Sending video
signal and power.
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2.4 Install to DIN rail

PS6000 Series has no mounting port for DIN rail/wall.

Please install product directly by flat screw for wall mount. Also Book mount adapter are available
(PFXYP6ADBMB)

Wall mounting

Book mounting

Chapter 3 Optional items

3.1 Options compatibility
Most of SP5000 series option are usable for PS6000 Atom Basic Box.
(Display option’s reference are for 15inch)

SP5000 series PS6000 series

Compatibily

COM Port Conversion Adapter PFXZC3ADCM1 4
Terminal Block Conversion Adapter PFXZC3ADR41 4
RS-232C Cable (5m) PFXZC3CBR251 4
RS-422 Cable (5m) PFXZC3CBR451 4
Mitsubishi PLC A-Series Connection Cable (5m) PFXZC3CBA51 4
9-pin-to-25-pin RS-232C Conversion Cable (0.2m) PFXZC3CBCVR21 &
Mitsubishi PLC FX-Series Connection Cable PFXZC3CBFX11 V4
Mitsubishi PLC FX-Series Connection Cable PFXZC3CBFX51 4
Mitsubishi PLC Q-Series Link Cable(5m) PFXZC3CBQL51 v
Mitsubishi PLC Q-Series Connection Cable (5m) PFXZC3CBQ51 &
Omron PLC SYSMAC Link Cable(5m) PFXZC3CBSYS51 <
Screen Protection Sheet PFXZC3DS151 &
Connects a USB printer. (TYPE-B) PFXZCOCBUS1 4
RS-422 Terminal Block Conversion Adapter PFXZCBADTM1 &
RS-422 9/25-pin Conversion Cable (0.2m) PFXZCBCBCVR41 4
Multi-Link Cable (5m) PFXZCBCBML1 <
SD Memory Card (4 GB) PFXZCBSD4GC41 <
EZ llluminated Switch PFXZCCEUSG1 v
Front USB cover for NEMA/ATEX PFXZCDCVUS1 4
SD Memory Card (1 GB) for System Card PFXZCDSD1GC61 4
Auxiliary Output / Speaker Output Interface PFXZCDCNAUX1 - *1
UV Protection Sheet PFXZCFUV151 -
Environment Cover PFXZCDOP151 -
Anti-Glare Sheet PFXZCHAG152 *2
Replacement Battery PFXZCBBT1

Multi Display Adapter PFXZCDADEXR1 *3

*1 Audio option with 3.5 Audio interface available (PFXYP6CVUSAU)
*2 New Anti-Glare Sheet available (PFXZCAG7W1
*3 PS6000 can connect with 3 displays. Detail on 2.4 Video output interface
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3.2 Options Slot table
Option Slot (except WiFi/Bluetooth) and 2nd M.2 SSD use same interface, so 2nd SSD could be only use
with WiFi/Bluetooth option or no option module.
Option slot fit only one option module frame, so option module can be use only one at a time.
RS-232C x2
RS422/485 x2
Ethernet
4G Cellular
WiFi/Bluetooth
No Option Module

R R

3.3 Option Interface of RS-422/485 isolated x2

This Option Interface has dip switch. Termination resistor setting is necessary. Set up by referring

to the following table. Switching RS-485 and RS-422 is also configured with the dip switch.

DIP SW OFF ON Description
1 Normal Termination (120 ohm) | for COM3. Default: OFF
2 Normal Termination (120 ohm) | for COM4. Default: OFF
3 RS-485 RS-422 Default: OFF
4 Unused (disabled) Default: OFF

= CJop

= (XN ] =}

[= (=N =] =1

A= D'Uc:l

e a—
SISy o > L@‘].
Il [

Along with DIP switch settings, both ports must be set in the Windows® Device Manager too.
NOTE: Auto direction control is automatically enabled with this setting.

1. Open the Windows® Device Manager.

2. Open Ports

3. Right-click the port to which RS-485 or RS-422 is assigned

12




}{ Device Manager
Eile  Action \iew Help
e m| m| e

» & DESKTOP-TEIQQSQ
> W Audio inputs and outputs
5 B Computer
> wm Disk drives
> [ Display adapters
> M Firmware
> {ir Human Interface Devices
> =g |DE ATA/ATAP| controllers
» =2 Keyboards
> . Mice and other pointing devices
» [l Monitors
> 3P Network adapters
5> [ Portable Devices
~ i@ Ports (COM & LPT)
W Communications Port (COM1)
@ Communications Port (COM2)
@ XR21B1422 USBE UART Ch A (COM3)
@ XR21B1422 USB UART Ch B (COM4)
» = Print queues
» [ Processors

4. Select Properties and open the Port Settings tab.
5. Select the RS-485 check box.

NOTE:

- Select the RS-485 check box even for RS-422.

- Do not change any settings other than RS-485.

XR21B1422 USB UART Ch A (COM3) Properties X
General Podt Settings Driver Detals Events
Bits per second: | 9600 |
Databts: [8 =l
Party: None ~|
Stop bits: |1 l]
Bow control: {None |
™ Wide Mode
% Low Latency Mode [50000 <] bos andless) Advanced.. | Restore Defauts |
| ¥ Bsae§ I(-‘ GPIO5  GPIO7 W Active High
[~ GPIOS CLK# GPIO7 Status r GPIO8 (TXT # r GPIOS (RXT #
unchecked) unchecked) unchecked)
@ Input @ Input & Input 6 ol
" Output Low " Output Low C Oulpat Lo C QOutput Low
‘® Output High | " Output High € Output High € Output High
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3.4 Option Interface of RS-422/485 isolated PIN assign
Option Interface of RS-422/485 isolated PIN assign is different with PS6000 Basi Box COM port and
SP5000 Open Box COM port.

Pin# PS6000 Basic Box SP5000 Open Box PS6000 Basic Box
COM port COM port RS422/485 x2 isolation option

1 RDA RDA TxD-/Data-

2 RDB RDB TxD+/Data+
3 SDA SDA RxD+

4 ERA ERA RxD-

5 SG SG SG

6 CSB CSB NC

7 SDB SDB NC

8 CSA CSA NC

9 ERB ERB NC

Chapter 4 Compatibility of software

4.1 Supported OS and language
The supported OS and language differ between SP5000 series and PS6000 series.

(OFS] SP5000 series PS6000 series
Windows Embedded Standard 7 Service Pack 1 Yes (PFXSP5B41) No
Windows 10 loT Enterprise 2019 LTSC Yes (PFXSP5B411/412) No
Windows 10 loT Enterprise 2021 LTSC (64 bit) No Yes
SP5000 series PS6000 series
Language Windows Embedgz(ikS;andard 7 Service Windows® 10 loT Enterprise 2021
Win 10 loT Enterprise 2019 LTSC LIS g
Chinese(Simplified) Yes/No *1 Yes
Chinese(Traditional) Yes/No *1 Yes
English Yes Yes
French Yes Yes
German Yes Yes
Italian Yes Yes
Japanese Yes Yes
Portuguese Yes/No *1 Yes
Russian Yes/No *1 Yes
Spanish Yes Yes
Swedish Yes/No *1 Yes

*1: It's necessary to add and install a language from the language pack.
*2: Language that is not shown in the table can be downloaded from the Microsoft web site using the
standard language feature of Windows.
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Settings

- o x
Windows Settings & settings - o
| || @ Home Language
| Find a setting o I Languages
i Windows display language
OO System Devices [ Time & Language play languag
Display, sound, notific Bluetooth, printers, mou: English (United States)
B Date &time Windows features like Settings and File Explorer will appear in this
language.
@ Network & Internet [ Pesonalistion g] © Region
Wi-Fi, airplane mods, VPN ground, lock screen, colors = Preferred languages
#* language Apps and websites will appear in the first language in the list that they
support. Press and hold (or select) a language, then drag to rearrange
them.

Accounts (T.,  Time & Language \
R our accounts, email, sync AT oo reqion, date 4 Addalanguage
wark, family
@, English (United States) fdlida
AF Default app language, Windows display language
Privacy - Update & Security
& SR

cation, camera Nindows Update, recovery,

backu Related settings

Date, time, & regional formatting

Administrative language settings

Spelling, typing, & keyboard settings

4.2 OS login password

For PS6000 series, it's necessary to set a login password at the first boot of the product to reduce the risk
of intrusion and infection of malicious software and unauthorized access. Unlike SP5000 series, you cannot
configure settings without a password. The conditions of login password are as follows;

The number of characters: 8 or more characters with 3 or more types included from the usable characters

as shown below. The character strings used for the account name cannot be used.

Types of usable characters:

® Upper-case characters of European languages (A to Z, diacritical mark, Greek alphabet, Cyrillic
alphabet)

® | ower-case characters of European languages (a to z, hash sign, Greek alphabet, Cyrillic alphabet)

® Numbers (0to 9)

® Characters (special characters) except alphanumeric characters: (~|@#$%"&*_-+="[¥({}{]:;"'<>,.?/) In
this policy setting, the currency sign like Euro or British Pound is not counted as special characters

® Unicode characters that are neither upper-case nor lower-case characters though they are categorized
in the order of alphabet. Unicode characters of Asian languages are included in this.

4.3 Recovery media

A recovery USB for OS recovery is attached to PS5000 series, but it's an optional item for PS6000 series.
Please purchase a recovery USB for PS6000 Basic Box (PFXYP6RUSW10B) for OS recovery.

Using the recovery tool *1 on our web site makes recovery possible with the backup file created in advance.
*1: https://www.proface.com/en/download/ps6000/application/restore_and_backup

15
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4.4 Supported software and utilities
The software and utilities supported by PS6000 series are as follows;

Software

GP-Pro EX (WinGP)

Version |

Ver. 4.09.500 or later

Pro-Server EX

Ver. 1.37.200 or later

Pro-face Remote HMI (i0S/Android)

Ver. 1.50 or later *1

Pro-face Remote HMI Server

Ver. 1.11.006 or later

Pro-face Remote HMI Client for Win

Ver. 1.42 or later

BLUE 3.4 Service Pack 1
BLUE Open Studio 2023
Pro-face Connect (Link Manager) 11.0
Pro-face Connect (Site Manager) 11.0

*1: For earlier than Ver.1.50, PS6000 series (WinGP) is not recognized as a connection destination server.

Utilit  Descriptons |

Buzzer Enable or disable the buzzer sound at the time of touch panel operation.

Brightness Sets the backlight brightness.

Calibration Correct touch positions.

Front USB Permit or do not permit use of Front USB on Display Module.

Write Filter Enable or disable the Write Filter feature.

HORM Enable or disable the HORM feature.

Shell Hige the Windows® desktop. Using this custom shell feature allows you to restrain the
Windows® features such as Control Panel.

Power Used to operate power supply of this product in a state of custom shell.

System Show the product’s firmware, BIOS version, and OS version.

Touch Mode Select from 3 modes (Normal, Water-detected, and Gloves) according to a use environment.

: Monitor a state of the main unit, for example temperature or voltage, using a dashboard created

System Monitor "\t Node-RED. PP 96,159

Window Locker Fix a window display position at the time of application boot when an external display is used.

Cellular Yo_u can use the optional in_terface unit and a S_IM cqrd_ to dat_a communicaftion _
using 3G, 4G, and LTE radio waves. Double-click this icon will show the windows cellular option.

4.5 Supported features in Launcher compatibility

The difference of supported System features in Launcher is as shown below.

SP5B411/412 SP5B41
(Windows 10) (WES?7)

PS6000

Atom Basic Box

Launcher Supported Supported Supported
Buzzer Supported Not supported Not supported
Brightness Supported Supported Supported
Calibration Supported Supported Supported
Front USB Supported Supported Supported
Write Filter Supported Supported Supported
HORM Supported Supported Supported
Shell Supported Supported Supported
Power Supported Supported Supported
System Supported Supported Supported
Touch Mode Supported Not supported Not supported
System Monitor Supported Not supported Not supported
Window Locker Supported Not supported Not supported
Cellular Supported Not supported Not supported
HMI Icon Not supported Supported Supported
1::E g\?ﬁgﬁg:/ Not supported Supported Supported
Eject Not supported Not supported Supported
UART Not supported Supported Supported

* Launcher similar with the SP5000 Open Box’s launcher will be release later.
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4.6 GP-Pro EX project file

Please follow below step in GP-Pro EX, to use SP5000 project file on PS6000.
1. Open the SP5000 project file.

2. Click Project > System Settings > Display.

3. Click Change Display.

4. Select as below for New Display fields.

- Series: IPC Series (PC/AT) — PC/AT

- Model: PC/IAT

- Screen Size: Select display size of PS6000 *1 e.g. 12.1” inch wide = 1280x800(WXGA)
- Orientation: Landscape or Portrait *Usually same with current Display

5. Click Change.

Display
Display Unit Change Display
Series SPE000 Series
Display Module  SP-BED0WA WXGA (12807800)+SP-5B41/5B8417
Orientation Landscape
i Change Display Unit X

Specffications

Screen Size 12.1inch Curent Display

Resclution 1280 x 800 pixels (WXGA) Series SP5000 Series

N . Box Module SP-bB41/5B41°
Display Unit TFT Color LCD
Display Module SP-5600WA WXGA (1280°800)
Display Colors 262,144 Colors Crientaion Landscape
Touch Panel Analog Touch Panel Analog

Internal Memory 64 MB

Backup Memery 320 KB @

COM1 RS-232C/RS-422{RS-485) Mew Display

comz RS-232C/RS-422{RS-485) Series IPC Series(PC/AT) ~

USB(A) 3 Ports PC/AT ~

USB{mini-B) 1 Ports Model PC/AT v

USB(micro-B) None

AN 2 Ports Screen Size 1280800 (WXGA) ~
QOrientation Landscape &

SDICFast On

Video Input Mone

Internal Board None

6. Two pop-ups will be shown in a row. Read the mention and click Yes.

=g
— Hardware features differ between different models.
| Changing the display unit might require changes to devices/PLCs or peripheral equipment.
. _,/ After you make any changes, confirm each setting.
‘when the touch panel format is different, touch input may not be recognized.

Confirm valid operation.
Do you want to change the model ?

o i

& GP-ProEX

The conversion process to regenerate font data may take some time. The amount of time required depends on the
[ project structure.
Continue?

ot

*When [Historical Data Retentive Settings] error has been shown, please follow logging the data other

than SRAM —4.8

Error Check

5"‘ H‘ H} €} Even if you save this data, you can't transfer it to the display unit.

Level |Error Numbsy Screen-Location Summary
Error 1085 Display Unit - IPC Settings  Unable to use [SRAM] in [Historical Data Retentive Settings] with this model. Please change it

*1 if resolution is different from current display. Convert Resolution check box will be shown. When you want
to convert to new resolution, put the check. After changing the resolution, ensure that the part and text sizes
and positions are appropriate.
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4.7 WinGP - Historical Data Retentive Settings

4.8.1 Logging to external device

When creating new project selecting IPC Series(PC/AT) — PC/AT, by enabling the logging, automatically
logging data will be save to external drive.

Minimum Historical Data Retentive Saving cycle will 1min. Saving enable size is bigger than SRAM.

4.8.2 logging the data other than SRAM

To setup D Drive for logging data, please follow below step in GP-Pro EX.

Select Project > System settings > Display Unit.

Select WinGP tab. Check the Folder and assign the location in Historical Data Storage Location

Historical Data Retentive Settings

Savein & Folder " SRAM
Historical Data Storage Location |
Save Condition [Fequeny =]
Frequency ,ﬁ‘ Msrutes
™ Indicate \write Status

Status Address @

4.8 BLUE Runtime License Manager
Please follow below step to transfer the RT license activation to PS6000 from SP5000 Open Box.

1. On SP5000 Open Box. Click Window Menu. Select Schneider Electric License Manager folder. Run
License Manager.

- Schneider Electric License Manager ~

License Manager

z Release Notes

i Srhneider Flartricr Snftuwara |Indate s
— 'Y
,O ™M o X P

2. Click check box on the left of BLUE Runtime License (1). Don’t forget to take a memo of Activation ID.
Click Return (2).

Schneider Electric License Manager - m} X

Task Options Help
8 sk @
Local  Floating
[[] Hide Trial Licenses

This table shows all available node-locked licenses.
[[] Hide Invalid Licenses

l MName Wersion  Part Number Activation ID ED);:érahon
¥ ; Y| BLUE Runtime License 30 PFXBLRCZLSPM30 ] I

A

Q) | st |BLUE trial 3.1 2024/04/18

< 2 >
Bctivate Complete Update Repair | Return

3. Pop up window explaining Returning License will be shown. Click Yes.

4. Pop up window explaining succeed of remove license will be shown. Click Finish.
18



5. On PS6000, Click Window Menu. Select Schneider Electric License Manager folder. Run

License
Manager.

6. Click Activate button.

[ Schneider Electric License Manager

- [m] X
Task  Options  Help
LA ¥ 4 @
Local  Floating
[ Hids Trial Licenses
This table shows all availsble nods-locked licensss
[ Hide Tnvalid Licenses
. Expiration
Name Wersion  Part Number #ctivation 1D e
BLUE Runtime License 0 PFHBLRCZLSPM30
@ Trial (BLUE trial al 2024704718

i

>
| Activate | Conplete Update Fepalr Eeturn

7. Enter Activation ID in step2 to text box (1)
Click Next > (2)

Schneider Electric License Manager
License Activation
“our computer iz connected to the Schneider Electric License Server

Please enter the Activation ID(s) 1
Enter multiple Activation IDs in separate lines.
p—

About Support Cancel Help

8. Pop up window explaining succeed of activating license will be shown. Click Finish.

*BLUE License has restriction of the number of deactivating and reactivating.
Please contact support center for further detail.
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4.9 BLUE Project file
Please follow below step in BLUE, to use SP5000 project file on PS6000.

1. Open the SP5000 project file.
2. Click System Architecture > TargetO1 (1) *1.
3. Click 3 dots on the Series (2).

GPS_LoggingDataDisplay01_WVGA.biu

BLUE -
D &~ By X|®v A~ B B B fij|l saecoom | v v [BvlD v L1 2?2 v FgVIEY
@ Driver gV i Q v 15 % @ @ ||D Aoperties i= =]
> meject Name Target01
o .
EﬁqSystemArch\tecture Type | Target
[
¢ iction Advanced @ >
> Screen Design 1
> & Scripts & Series SP5 ED
> [ Variables Model SP5 D 2
> [& Alarms/Events .
s Resolution
I> ELoggmg
Orientation Landscape
>

Recipes I_ o
4. Select as below for New Display fields.
- Type: IPCor PC/AT
- Resolution: Select display size of PS6000 (e.g. 12.1” inch wide = 1280x800(WXGA)
- Orientation: Landscape or Portrait *Usually same with current Display
5 Click OK.
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4.10 BLUE historical data location

When select IPC or PC/AT, selection for logging data, for Logging and Alarm. will be Backup Memory or SD
Card*1 or USB Storage*1.

Below is the location of logging data for each selection.

Please beware to re-assign the location when you change the project file to IPC or PC/AT from SP5000.

E Scripts Operation When [Save in] Is Full ~ Overwrite Old D...

E Variables bd Save in Backup Memory v
- & Alarms/Events X
Encryption Backup Memory

> [ Al Alarms (0)

" > Export Data SD Card
Operation Log
- > Export Status USB Storage
g Loggin
99ng Hi/Lo Status Behavior Remain Active 0...

Backup Memory

Save to Folder will be automatically created in the C Drive.

SD Card
USB Storage
Location can assign in System Architecture > TargetO1 > Function > Options > Destination Folder.

~ B2 System Architecture

b [ Targeto1

Type

Function Advanced @ @

> Screen Design —
> = Scripts Basic Options
> [ Variables
" Preferences
> [& Alarms/Events
User Language ID O
> & Logging
&= Gesture Switches
> Recipes
> [ Security Destination Folder (SD Card) ~ C:¥SDCardl
s C¥USBSt
> Language Table Data Location = System = Variable ~Alarmlog ~ Oper v Destination Folder (USB Storage) orage

*1 simply selecting [SD Card] or [USB Storage] will NOT store the alarm history in the SD card or USB
storage inserted in the display unit. To save the alarm history in the SD card or USB storage, specify the
destination folder in the [Destination Folder (SD Card)] or [Destination Folder (USB Storage)]
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4.11 Software notice when Writer Filter is enabled

When Write Filter(UWF) is enabled, data will be reset when restarting the product.

Software data such as variable data, will be also reset. If you need to avoid this, please create symbolic link
of software folder to second device or external device.

Default software folder:
BLUE : “C:¥ProgramData¥Pro-face¥BLUE Runtime”
GP-Pro EX : “C:¥ProgramData¥Pro-face¥WinGP”

Example of creating BLUE symbolic link folder C:¥ProgramData¥Pro-face¥BLUE Runtime
1. Disable Unified Write Filter
a. Start Launcher from the shortcut icon on the Desktop

=

Recycle Bin

Launcher

b. Select Write Filter from Launcher top screen
If Write Filter is not displayed on the Launcher top screen, click on Edit to display Write Filter

c. Disable (Off) Write Filter on C:

Write Filter )4

Toggle the switch to Off

2. Create a new folder D:¥PS6000.

3. Cut and paste BLUE Runtime folder from the C:¥ProgramData¥Pro-face to D:¥PS6000 folder.
Ensure to Cut and Paste, and not to Copy and Paste

Note: C:¥ProgramData is a hidden folder by default in Windows. Please enable Hidden items from View
menu on Windows Explorer Window.
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Fore ns i) Large icons 4 Medit
List Detail
ctails pane )
This PC > Windows (C) » ProgramData » Pro
O w

[ ' BLUE Runtime

Open
Open in new window
Pin to Quick access

B Classify and protect

& Add to VIC media player's Playlist

& Play with VLC media player

W scan for threats
7-Zip >
Give access to B>

Restore previous versions

Include in library >
Pin to Start

Send to >
Cut

Copy

Create shortcut
Delete

Rename

Properties

Folder to Cut from C: drive.

4. Click Windows Start button > Open Command Prompt as Administrator

Best match

Command Prompt
System

Search work and web
Command Prompt

A cmd run as administrator - Se

and web results

cmd
7 Open

cmd prompt
Run as administrator

apd commands R Run as different user

cmd ipconfig

cmd commands list Pin to Start

cmd administrator command Pin to taskbar
cmdf

cmder

cmdemd

® ® © o o b b oo

4. Input < mklink /D “C:¥ProgramData¥Pro-face¥BLUE Runtime” “D:¥PS6000¥BLUE Runtime”> and press

Enter key.
After successful creation of the symbolic link, there will be following message:
“symbolic link created for C:ProgramData¥Pro-face¥BLUE Runtime<<===>>D:¥PS6000¥BLUE

Runtime”

. '‘BLUE Runtim
ymbolic link created for C:/ProgramD ¢ LB UE Runtime

5. Enable Write Filter for C: drive
a. Start Launcher from the shortcut icon on the Desktop
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o

Recycle Bin

Launcher

b. Select Write Filter from Launcher top screen
If Write Filter is not displayed on the Launcher top screen, click on Edit to display Write Filter

Application Launcher

c. Enable (On) Write Filter on C:

Write Filter h 4
L. N g n

Toggle the switch to On.
Only Alarm, logging and historical data needs to avoid the reset, changing the save folder to external device
will resolve this concern. GP-Pro EX —»See 4.8 BLUE —See 4.11
However, even in this case, PS6000 needs to be shut down correctly from Windows. If there is a shut down
from other cases (e.g. power supply cut-off to PS6000), data could be damaged and could cause issues in

saving.

Using the symbolic link to protect variable data from resetting require two separate storage drives.
(Symbolic link will not work properly for virtually partitioned drives)
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